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What is Workshare Professional

Workshare Professional reimagines multi-party review and collaboration and ensures the 
safe and accurate exchange of information, enabling the collaborative evolution of high 
value business documents. 

Workshare Professional is a desktop application that automates managing changes to 
business documents, protects against unauthorized content disclosure and delivers the 
world’s most secure PDF creation, all in one integrated solution.

Key features of Workshare Professional include:

 Comparison of Word, PowerPoint, Excel and PDF files, including image-based 
PDF files

 Comparison of selected pieces of content, such as a single paragraph or clause

 Ability to accept/reject in a comparison and then create new documents

 Advanced comparison features including one-to-many comparisons (Word and 
PDF files), version comparisons, and access from within Office and Document 
Management Systems

 Access to comparison functionality from within Outlook as well as right-click access 
from within individual emails

 Conversion from PDF to DOC format for local files and from within the DMS/CRM

 Advanced, interactive metadata cleaning/PDF creation/secure file transfer for 
attachments in Outlook

 Comprehensive content risk protection enabling the discovery and removal of 
hidden sensitive data as well as visible sensitive data

 Options to save and share Office documents to Workshare online

 Access and visibility into online collaborative workspaces directly from Office

 Secure file sharing from all devices and browsers with metadata removal and end-
to-end encryption

 Centralized policy design and enforcement administrator tools

 ECM/DMS and OCR integration with desktop comparison features

 Centralized user account management and control

 Complete access to Workshare online functionality to share and collaborate on 
documents, including setting folder access and permissions, positional commenting 
and reviewer communications with presence indicators

 Desktop sync app to synchronize your online content to your local desktop
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Note: Workshare Professional can be installed without Microsoft Office integration. In this 
case, the comparison functionality is only available from the Workshare comparison
applications and the metadata removal functionality is only available when sending 
emails.

What’s New in Workshare Professional 10.1

The Professional 10.1 release includes the following:

Send multiple redlines

When multiple redlines are open in Compare, they can all be attached to a single email.

Selecting this option lists all the redlines currently open (each in a different tab in the 
Workshare Compare window) and the user selects which to attach to the email.

Launch new comparison in open Compare

When launching a new comparison with one already open in Workshare Compare, the 
new comparison will be displayed in a new tab in the same instance of Workshare 
Compare.

This functionality is enabled using the new configuration option Launch new comparison 
in running instance.
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Support for iManage elastic cloud

Workshare Professional integrates with an iManage Work 10 multi-tenant server 
infrastructure (elastic cloud). This is when Work 10 is hosted, maintained and owned 
entirely by iManage. This infrastructure is able to securely handle multiple customers.

Enhanced Excel chart comparisons

The comparison of charts in Compare for Excel is even better.

One useful tool for users is that where changes have been made to an overlaid object, 
such as charts, shapes, images, etc., users can toggle between the original and modified 
object to quickly and clearly see what has changed.

Environment changes

 Added support for iManage Work 10 elastic cloud

Workshare Configuration Manager

The following parameters were added:

 Launch new comparison in running instance (Comparison > Administration

 Default Server (Integrations > iManage)

 Use Work 10 integration for all registered servers (Work 10 only) (Integrations 
> iManage)

For some of the parameters in the Integrations > iManage category, “Legacy only” has 
been added to the name to clarify that the parameters apply to pre-Work 10 environments 
only.
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System Requirements

The recommended system requirements for Workshare Professional 10.1 are:

 Intel Core i3 @ 2.5GHz

 AMD Athlon 64 X4

 4GB RAM

Workshare Professional 10.1 has a 32-bit version for 32-bit Microsoft Office environments 
and a 64-bit version for 64-bit Office environments.

Certified Environments for Workshare Professional 10.1
(32-bit version)

Workshare Professional 10.1 (32-bit version) has been tested and certified in a number of 
environments. If your environment is not included in the following list, it may still be a 
compatible environment. Contact Workshare Customer Support 
(support@workshare.com) for any help.

For details of which environments previous versions of Workshare Professional/Compare/
Protect were certified against, refer to previous versions of release notes on the 
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us 
language set.

Operating System:

 Microsoft Windows 10 (32 bit and 64 bit)

 Microsoft Windows 8.1 (32 bit and 64 bit) + Japanese

 Microsoft Windows 7 SP1 (32 bit and 64 bit) + Chinese Simplified & French

Citrix:

 With Microsoft Windows Server 2012 R2 or 2016 (64 bit)

 Citrix XenApp 7.5 

 Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports 
your version of Citrix. 

Microsoft Office System:

 Microsoft Office 365 (desktop)

 Microsoft Office 2019 (32 bit) – including click-to-run

mailto:support@workshare.com
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 Microsoft Office 2016 (32 bit) – including click-to-run

 Microsoft Office 2013 SP1 (32 bit) + Japanese – including click-to-run

Email System:

 Microsoft Outlook 365 (desktop)

 Microsoft Outlook 2019 (32 bit)

 Microsoft Outlook 2016 (32 bit)

 Microsoft Outlook 2013 SP1 (32 bit) + Japanese

 IBM Notes 9.0.1 FP7, FP8 and FP9

Note: Interactive Protect and the replace email attachment with link features of 
Workshare are not supported in a Notes environment.

Browsers:

 Microsoft Edge, latest version

 Microsoft Internet Explorer 11

 Google Chrome, latest version

 Mozilla Firefox, latest version

Microsoft SharePoint:

 Microsoft SharePoint 2013 SP1

DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports 
your DMS. 

 NetDocuments

ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send 
to application functionality, Microsoft Internet Explorer must be installed 
(although it does not have to be the default browser).

 iManage clients:

 FileSite/DeskSite 9.0 Update 6 and above

 Work 10 Desktop for Windows 10.0 and above

 Work 10 web client (You will need to install Workshare iManage Integration 
Server in order to launch comparisons from the iManage browser interface.)

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
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Note: If you use a Work 10.2 server, it must include iManage Work Web Server 
10.2.0.91 (which can be requested from iManage with reference CSAR-2673).

 OpenText: 

 eDOCS DM 16.3

 eDOCS DM 10

 eDOCS DM 5.3.1 COM only (Patch 6)

 Worldox:

 GX4

Workshare will endeavor to support future service packs of certified environments.

Certified Environments for Workshare Professional 10.1
(64-bit version)

Workshare Professional 10.1 (64-bit version) has been tested and certified in a number of 
environments. If your environment is not included in the following list, it may still be a 
compatible environment. Contact Workshare Customer Support 
(support@workshare.com) for any help.

For details of which environments previous versions of Workshare Professional/
Compare/Protect were certified against, refer to previous versions of release notes on the 
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us 
language set.

Operating System:

 Microsoft Windows 10 (64 bit)

Citrix:

 With Microsoft Windows Server 2012 R2 (64 bit)

 Citrix XenApp 7.5 

 Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports 
your version of Citrix. 

Microsoft Office System:

 Microsoft Office 365 (desktop) (64 bit)

 Microsoft Office 2019 (64 bit)

 Microsoft Office 2016 (64 bit)

mailto:support@workshare.com
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 Microsoft Office 2013 SP1 (64 bit)

Email System:

 Microsoft Outlook 365 (desktop) (64 bit)

 Microsoft Outlook 2019 (64 bit)

 Microsoft Outlook 2016 (64 bit)

 Microsoft Outlook 2013 SP1 (64 bit)

Browsers:

 Microsoft Edge, latest version

 Microsoft Internet Explorer 11

 Google Chrome, latest version

 Mozilla Firefox, latest version

DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports 
your DMS. 

 NetDocuments

ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send 
to application functionality, Microsoft Internet Explorer must be installed 
(although it does not have to be the default browser).

 iManage clients:

 FileSite/DeskSite 9.3 (64 bit) and above

 Work 10 Desktop for Windows 10.0 (64 bit) and above

 Work 10 web client (You will need to install Workshare iManage Integration 
Server in order to launch comparisons from the iManage browser interface.)

Note: If you use a Work 10.2 server, it must include iManage Work Web Server 
10.2.0.91 (which can be requested from iManage with reference CSAR-2673).

 OpenText: 

 eDOCS DM 16.3

 eDOCS DM 10

Workshare will endeavor to support future service packs of certified environments.

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
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Important Information

Secure PDFs – Workshare Professional is unable to compare secure PDFs or convert 
secure PDFs to Word format. Secure PDFs are PDF files with security settings configured.

POP/IMAP – Workshare Professional does not support Outlook when it is configured with 
a POP or IMAP account.

Important installation information

 Workshare Professional installs program files to a sub-folder within the Workshare 
folder named Modules.

 Install: A user is unable to install Workshare Professional if Microsoft Windows 
Installer 3.1 is not installed. This can be downloaded from the following location 
https://www.microsoft.com/en-us/download/details.aspx?id=25.

 Windows 7: When UAC is set to Default, running the Workshare Professional 
install displays the UAC prompt. You must approve the prompt and Workshare 
Professional will be installed. Running the Workshare Professional MSI silently will 
fail when UAC is set to Default because the user is not given the opportunity to 
approve the UAC prompt. Therefore for silent installs, disable UAC.

If you have installed any Alpha or Beta builds of Workshare Professional, we strongly 
recommend that you first uninstall them before installing Workshare Professional 10.

Change Requests Fixed

The following are fixed customer change requests that have been validated for this release 
- for more information, please contact Customer Support.

CR# Ref Description

CR01163003 PRO-2585 'This setup requires 32-bit Microsoft Office 2013 SP1 or 
later' when installing the software on Office 2013 Click to 
run

CR01161972 PRO-2302 The file cannot be found' error message appears when 
manually changing the version number in the comparison 
path selected from any Document Management System

CR01160972 PRO-2147 Comparison displayed as Text only redline when 
comparing documents using Standard mode and unable 
to compare them in Fast mode

CR01160973 PRO-2085 Compare for Excel does not display the version number 
when comparing from OpenText

https://www.microsoft.com/en-us/download/details.aspx?id=25


Workshare Professional 10.1 Release Notes

11

CR# Ref Description

CR01160584 PRO-2007 iManage integration - Unable to start a comparison from 
the browser to Compare desktop

CR01160503 PRO-1960 Boxes appear around text when comparing certain 
documents in Fast mode

CR01160265 PRO-1922 Unable to view specific exported Excel comparison file

CR01159942 PRO-1911 Original file not found' warning message appears if a 
previous document is selected from the drop-down list in 
the compare window & the file no longer exists and upon 
selecting a new file.

CR01159377 PRO-1874 Floating 'Change Summary' panel is black when 
comparing documents

CR01156949 PRO-1830 Korean auto-numbering characters appear as numbers in 
the comparison

CR01158511 PRO-1818 Comparison mode is blank if the file name contains a "-" 
& if "Display document description as well as document 
ID" option is enabled

CR00733773 PRO-1817 Ability to rename or delete Group Default profile name

CR01156525 PRO-1693 Chinese characters incorrectly displayed within the 
comparison when system locale is set to Chinese 
(Traditional, Hong Kong SAR)

CR01153620 PRO-1660 Numbering list and paragraphs not displayed when 
comparing specific docs in Fast Mode

CR01153693 PRO-1630 Date and recipient name are incorrectly displayed in the 
comparison when using letter template created from Forte 
application

CR01152897 PRO-1618 The preparation failed for this comparison error displayed 
when comparing checked-out documents from 
NetDocuments

CR01150842 PRO-1546 Comments are missing when saving specific redline as 
Word document with Track Changes

CR01137284 PRO-1131 Unable to detect metadata for XLSX documents with 
check-boxes

CR01135979 PRO-1090 Unable to detect metadata for DOCX documents when 
containing drop-down lists

CR01079049 PRO-900 "Combine files in Workshare" does not process more than 
sixteen items

CR01065350 PRO-816 Unable to access Help feature from Content Risk window
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CR# Ref Description

CR01065781 PRO-799 Temporary file path shows instead of actual path for the 
modified document when comparing from NetDocuments

CR01125792 PRO-683 Unable to save redline as .DOC or .DOCX when 
comparing certain documents

CR01117856 PRO-566 Header is missing in the comparison when comparing 
specific documents

CR01100155 PRO-167 Unable to save specific comparison as Word document 
with Track Changes

Known Issues

The following are known issues in the Workshare Professional 10.1 release - for more 
information, please contact Customer Support.

Ref Description

PRO-2513
Errors can occur when using Selective Compare if Compare dialogs are 
open and the "Launch new comparison in running instance" configuration 
option is enabled.

01157226
The error ‘0x80004005’ is displayed and users are unable to save 
comparison documents when using iManage Work 10 with certain custom 
fields configured.

01163333 Links in Excel documents are detected again even after removal.

01164585
64-bit: The iManage dialog box is being displayed behind the Workshare 
desktop application window.

01130757
After running a comparison in Workshare Compare, some Chinese 
comments may not be displayed in the redline.

01085082
After running a comparison in Workshare Compare, certain financial tables 
may show incorrect insertions and deletions.

01129790
The OpenText save dialog appears in the background when saving redlines
to OpenText.

01125849
The error ‘80040154 Class not registered (Exception from HRESULT: 
0x80040154(REGDB_E_CLASSNOTREG))’ is displayed when sending 
documents to Compare from NetDocuments on Citrix.

01157234
PRO-1763

iManage Work 10: When saving a comparison to iManage from Workshare 
Compare, the security for the document is set to Private by default.

PRO-1504
Compare for Excel: The empty cell is not highlighted as inserted/deleted 
along with the rest of the changed row/column on comparing documents 
having empty column and with inserted/deleted rows.
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Ref Description

PRO-1387
Compare for Excel: Changes may not be indicated correctly when 
comparing spreadsheets with a deleted/inserted column when the first row is 
empty.

PRO-1386
Compare for Excel: Merged cells are displayed as individual cells when the 
merged cell is not in full view on the comparison window.

PRO-1019
Compare for Excel: Focus is not completely applied to the last change in the 
comparison window if the user clicks the Last Change button for the first 
time.

01061816
PRO-837

After running a comparison in Workshare Compare, the right aligned text in 
the footer may move to become center-aligned.

01088791
PRO-792

After running a comparison in Workshare Compare, some line numbering
and table text and row cells maybe be missing.

PRO-690
01125849

When sending documents for comparison from NetDocuments, the following 
error is displayed even though the documents are compared successfully: 
“80040154 Class not registered (Exception from HRESULT: 
0x80040154(REGDB_E_CLASSNOTREG))”.

PRO-528
IBM Notes 9.0.1 FP7 only. Attachments are duplicated in sent items when 
the email is processed through desktop profiles or all mail profiles. This is an 
issue with IBM Notes.

PRO-527
IBM Notes only. Attachments are not automatically compressed to a zip file
when the limit specified in the WCM is reached.

PRO-525
The positioning of signature components in RTF format emails can be 
incorrect after processing with Protect.

PRO-109
01099537

The error ‘Failed to compare documents. Unable to convert documents.’ is 
displayed when comparing specific scanned PDF documents.

PRO-22
The Reset Layout option is missing from the Quick Access Toolbar 
drop-down in Compare for PowerPoint.

01012100
The account or company name is not displayed in File > Help > About in 
Workshare Compare.

01018577
Worldox document footer stamps are not updated when saving a 
comparison via Save As in Workshare Compare.

01018743
The font in the email body changes to Times New Roman when sending 
attachments to groups in Interactive Protect.

01028440
Editing a rendering set on the fly does not prompt to save as a new set or 
overwrite the current rendering set.

40418
When comparing particular presentations, 'Index was outside the bounds of 
the array' error is displayed.

http://www-10.lotus.com/ldd/fixlist.nsf/8ed1b46cfdba8957852570c90054623b/dbf1eb80caf496f0852580d800738d12?OpenDocument
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Ref Description

40430
When comparing presentations and at least one has the Opulent design 
theme applied, a ‘Color is not resolved yet’ error is displayed.

40469
In Compare for PowerPoint, a newly created comparison theme does not 
appear in the Select dropdown in the Home ribbon (Comparison Themes 
group).

40574
A user is not automatically logged into Professional after logging into the 
desktop app first (64-bit version only).

40597
The local file store dialog is displayed when browsing for files from the 
desktop app when a DMS is set as the default (64-bit version only).

41284
In Compare for PowerPoint, comparisons of DMS files are not listed in the 
recent comparison list (File > Open > Recent).

41547
When a PowerPoint presentation is run from the command line, the incorrect 
comparison theme is highlighted under the Select dropdown in the Home 
ribbon.

45583
When a machine is restarted before the convert to link process has 
completed, files which are not synced are moved to a conflict state in the 
desktop app.

Contact Info

For technical help and support on Workshare products, contact Workshare Customer 
Support:

support@workshare.com
EMEA: +44 207 539 1400
US: +1 415 590 7705

For sales enquiries, contact the Workshare Sales team:

sales@workshare.com
EMEA: +44 207 426 0000
US: +1 415 590 7700
APAC: +61 2 8220 8090
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Workshare Ltd.
© 2019. Workshare Ltd. All rights reserved.

Copyright
Workshare Professional and Workshare DeltaView are registered trademarks of Workshare Ltd. Workshare Compare, 
Workshare Protect, Workshare 3, Workshare DeltaServer, SafetyGain, and the Workshare logo are trademarks of 
Workshare Ltd. All other trademarks are those of their respective holders.

Trademarked names may appear throughout this guide. Instead of listing these here or inserting numerous trademark 
symbols, Workshare wishes to state categorically that no infringement of intellectual or other copyright is intended and 
that trademarks are used only for editorial purposes.

Disclaimer
The authors/publishers of this guide and any associated help material have used their best efforts to ensure accuracy
and effectiveness. Due to the continuing nature of software development, it may be necessary to distribute updated help 
from time to time. The authors would like to assure users of their continued best efforts in supplying the most effective 
help material possible.

The authors/publishers, however, make no warranty of any kind, expressed or implied, with regard to Workshare 
programs or help material associated with them, including this guide. The authors/publishers shall not be liable in the 
event of incidental or consequential damages in connection with, or arising out of, the programs or associated help 
instructions.

For details of Workshare patents, see www.workshare.com/patents

Revisions
Published for Workshare Professional 10.0: 18/12/18; minor revisions: 17/1/19 & 15/2/19
Revised for Workshare Professional 10.1: 27a/3/19

Workshare Ltd., 20 Fashion Street, London E1 6PX www.workshare.com

http://www.workshare.com/patents
http://www.workshare.com/
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